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Zużyty sprzęt 
elektryczny 
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EE0066 Jednostka emitera laserowego. Seria MC 4.0

EE0145	 Jednostka	wyłącznika	krańcowego.	Seria	MC	4.0

EE0065 Odbiornik lasera. Seria MC 4.0

EE0034	 Niezapięty	kabel	Grove	1m	/2m	/50cm	/20cm	
/10cm	/5cm.	Seria	MC	4.0

EE0144	 Mechaniczna	jednostka	przycisku	klucza.	Seria	
MC 4.0

EE0096	 Kabel	przejściowy	Grove2Dupont	20	cm	(5	par).	
Seria MC 4.0

EE1850	 Jednostka	RFID	2.	Seria	MC	4.0

EE8563	 Jednostka	zegara	 czasu	 rzeczywistego	(RTC).	
Seria MC 4.0

EE0063	 Miniwentylator.	 Silnik	 magnetyczny	 N20	 ze	
śmigłami.	Seria	MC	4.0

EE3144	 Jednostka	efektu	Halla.	Seria	MC	4.0

EE6988	 Jednostka	ENV	III	z	czujnikiem	ciśnienia	powie-
trza	o	temperaturze	i	wilgotności.	Seria	MC	4.0

EE0076	 Serwo	SG90	360	stopni.	Seria	MC	4.0

EE0135 Jednostka enkodera. Seria MC 4.0

EE0101	 Jednostka	 nawadniająca	 z	 czujnikiem	wilgoci	
i	pompą.	Seria	MC	4.0

EE2812	 Płytka	LED	Neo	HEX	RGB.	Seria	MC	4.0
EE0120	 Moduł	baterii	13,2	(1500	mAh).	Seria	MC	4.0
EE0154	 Jednostka	kątowa	25,8	z	potencjometrem.	Seria	

MC 4.0
EE0041	 Koncentrator	we/wy.	Seria	MC	4.0
EE7620	 Czujnik	rozpoznawania	gestów.	Seria	MC	4.0
EE0133	 Moduł	4-kanałowy	analogowy	do	modułu	12C	

13.2	Wejście	4-20mA.	Seria	MC	4.0
EE1855	 Jednostka	 Kmeter	 z	 czujnikiem	 temperatury	

termopary.	Seria	MC	4.0
EE0122	 Moduł	wielokanałowy	4IN8OUT	napędu	prądu	

stałego.	Seria	MC	4.0
EE9685	 Moduł	SERVO2	16	kanałów	13.2
EE6501	 Moduł	COM.LoRaWAN	915MHz	z	anteną.	Seria	

MC 4.0
EE8825	 Moduł	sterownika	silnika	krokowego.	Seria	MC	4.0
EE0126	 Moduł	wyświetlacza	13.2.	Seria	MC	4.0
EE0003	 Moduł	GPS	z	anteną	wewnętrzną	i	zewnętrzną.	

Seria MC 4.0
EE1000	 Ultra-Wideband	(UWB)	Moduł	pozycjonowania	w	pomiesz-

czeniach.	Seria	MC	4.0

EE0640	 Jednostka	kamery	termowizyjnej.	Seria	MC	4.0

EE7023	 MC	4.0.	Zestaw	uzupełniający	AIoT
EE7009	 MC	4.0.	Zestaw	podstawowy
EE7016	 MC	4.0.	Zestaw	podstawowy	+	uzupełniający	AIoT

Zestawy:

Mechanizmy uzupełniające:

Zestawy  
dla przyszłych  
pokoleń  
programistów
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Zestawienie elementów

pilot MC4.0

czujnik podążania  
za linią RGB

sprzęgło  
wału silnika

śrubki M3 x 25

nakrętki M3

czujnik  
ultradźwiękowy

mosiężne kołki

śrubki M4 x 8

kable silnikowe

śrubokręt

śrubki M3 x 30 śrubki M4 x 10

przewody Grove

moduł silnika

moduł baterii

bateria litowa

podwozie

dodatkowa oprawa silnik prądu stałego

koła Mecanum

31

Firmware to rodzaj oprogramowania instalowanego na urządzeniu 
sprzętowym, takim jak zestaw MC4.0, i zapewniający niskopoziomo-
wą kontrolę nad funkcjami urządzenia. Zwykle ma na celu kontrolowa-
nie zachowania sprzętu, zarządzanie interakcjami z innymi urządze-
niami i zapewnianie stabilnej platformy dla aplikacji działających na 
urządzeniu. Oprogramowanie sprzętowe jest często preinstalowane 
na urządzeniach, ale można je również zaktualizować lub wymienić 
w celu poprawy funkcjonalności lub rozwiązania problemów.

Należy pamiętać, że w przypadku zmiany platformy Arduino z powro-
tem na UIFlow, konieczne będzie ponowne zainstalowanie oprogra-
mowania sprzętowego. Dzieje się tak dlatego, że oprogramowanie 
sprzętowe jest inne dla każdej platformy, a  przełączanie między nimi 
wymaga aktualizacji oprogramowania sprzętowego.

Aby zainstalować oprogramowanie sprzętowe w zestawie MC4.0, 
wykonaj następujące kroki:
1. Najpierw pobierz najnowszą wersję oprogra-

mowania z  oficjalnej strony Maker & Coder. 
Można je znaleźć w sekcji „References” 
(Referencje) na stronie produktu MC4.0 lub 
skorzystać z tego adresu URL:

https://makerandcoder.com/downloads/
Software/MC4.0%20Firmware.exe
2. Następnie podłącz zestaw MC4.0 do kom-

putera za pomocą kabla USB.
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Otwórz poniższy przykład w obszarze „File> 
Examples> M5Core2> games> floppybird” 
(Plik > Przykłady > M5Core2 > gry > floppy-
bird).

W tym przykładzie pokażemy, jak sterować ze-
stawem MC4.0 za pomocą Arduino IDE. Na 
początek będziemy musieli dołączyć wymagane 
biblioteki i pliki. Będziemy używać trzech plików: 
dwóch dla sterowników silników i jednego dla 
obrazu MC4.0, który będzie wyświetlany na 
ekranie. W funkcji konfiguracji zainicjujemy 
MC4.0 i ekran. Następnie będziemy przesuwać 
zestaw w określonej kolejności, z 1,5 sekundy 
na każdy ruch: w lewo, w prawo, do przodu, do 
tyłu i w niektórych kierunkach ukośnych.

3

Jak zbudowany jest MC4.0?

1. Przycisk zasilania.
2. Wejście USB tyu C.
3. Port A-12C.
4. Ekran dotykowy.

5. Wyświetlacz LCD 2’’ 320x240.
6. Przycisk do resetowania.
7. Dioda LED.
8. Wejście na kartę SD.

Co jeszcze można znaleźć w środku MC4.0?

 głośnik IMU 1W.
 zegar czasu rzeczywistego.
 bateria 3,7 V/390 mA.

 silnik wibracyjny.
 mikrofon.

Tutaj	możesz	obejrzeć	
wideo	dotyczące	

montażu.	 
Zeskanuj	kod	QR.

Instrukcja montażu

Złóż robota edukacyjnego  
i rozpocznij swoją robotyczną podróż.

MC4.0 to najbardziej pomysłowy na świecie ze-
staw AIoT do robotyki wielokodującej, przezna-
czony dla każdego ucznia, od dzieci ze szkoły 
podstawowej po studentów, zaprojektowany tak, 
aby móc poznać wszystkie koncepcje STEM (na-
uki ścisłe, technologię, inżynierię, matematykę) 
i doświadczyć zalet mechaniki, elektroniki, syste-
mów sterowania i informatyki.
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Podłącz MC4.0 do swojego komputera. Po otwarciu Arduino IDE wy-
konaj następujące kroki:

1. Wybierz swój kontroler z menu „Tools> Board menu> Maker&Coder> 
MC4.0” (Narzędzia> Płyta> Maker&Coder> MC4.0).

2. Z menu „Tools” (Narzędzia) wybierz Port (jeśli nie widzisz portu 
COM w swoim Arduino IDE, musisz zainstalować sterownik MC4.0).

3. Aby zainstalować sterownik USB dla MC4.0:



28

W wyskakującym okienku kliknij „INSTALL ALL” (ZA IN STA LUJ WSZY STKO)
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GOTOWE!
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3. Wyszukaj MC4.0 i naciśnij przycisk instalacji (install) dla „Maker & 
Coder”:

Otwórz „Libraries Manager” (Menedżera bibliotek): „Sketch>Include 
Library>Manage Libraries” (Szkic > Dołącz bibliotekę > Zarządzaj 
bibliotekami).

Wyszukaj M5Core2 i naciśnij przycisk instalacji (install) dla „M5Stack”:
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1. z menu „File” (Plik) wybierz „Preferences” 
(Preferencje), następnie w oknie dialogowym 
Preferencje w polu „Additional Board 
Manager URLs” (Dodatkowe adresy URL 
Menedżera Tablic) wpisz:

https://makerandcoder.com/downloads/
Arduino_IDE/MakerAndCoder_index.json

2. Otwórz „Boards Manager” (Menedżera tablic). Przejdź do 
„Tools>Board>Boards Manager” (Narzędzia > Tablica > Menedżer tablic).
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Instrukcje okablowania

Podłączmy robota i ożywmy go!

Niezależnie od tego, czy jesteś początkującym, czy zaawansowanym 
użytkownikiem, MC4.0 oferuje kompleksowy zestaw instrukcji okablowa-
nia, które pomogą Ci zrozumieć zasady elektroniki i systemów sterowania.

1

2 3

GOTOWE!

START!
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Zaczynajmy!

Gotowy do uwolnienia pełnego potencjału zestawu MC4.0?

Zacznijmy od zestawu MC4.0! W tej sekcji przeprowadzimy Cię 
przez kolejne etapy obsługi robota i podłączenia go do sieci Wi-Fi, 
dzięki czemu będziesz mógł rozpocząć odkrywanie świata robotyki 
i AIoT.

1

2

START!
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Witamy w świecie MC4.0! W tej sekcji przedstawimy Ci kompatybil-
ność z Arduino IDE. Dowiesz się, jak pisać, kompilować i przesyłać 
programy do swojego zestawu, a także zdobędziesz praktyczne do-
świadczenie w kilku podstawowych projektach. Niezależnie od tego, 
czy jesteś początkującym, czy doświadczonym programistą, ta sekcja 
zapewni Ci wiedzę potrzebną do rozpoczęcia programowania MC4.0 
w Arduino IDE. Zanurzmy się więc i odkryjmy nieskończone możliwości!

Przed rozpoczęciem procedury instalacyjnej musisz 
mieć zainstalowane na swoim komputerze Arduino 
IDE. Istnieją dwie wersje Arduino IDE, które można 
zainstalować: wersja 1 i wersja 2.

Możesz pobrać i zainstalować Arduino IDE, skanując 
kod QR:

Aby zainstalować MC4.0 w Arduino IDE, postępuj 
zgodnie z  poniższymi instrukcjami:
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Śledź platformę edukacyjną na naszej stronie internetowej, aby uzyskać 
dostęp do bogactwa wiedzy i przygotować się na przygodę z Pythonem!

9
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Programowanie blokowe

Odkryj prostotę programowania blokowego dzięki UiFlow!

Programowanie blokowe za pomocą UiFlow zostało zaprojektowane 
tak, aby było łatwe i  proste, nawet dla początkujących. W tej sekcji 
pokażemy, jak używać UiFlow do tworzenia kodu dla zestawu MC4.0 
w zabawny i interaktywny sposób. Dzięki interfejsowi wizualnemu po-
dobnemu do Scratch, UiFlow ułatwia rozpoczęcie programowania 
i urzeczywistnienie swoich pomysłów.

„Hello, world” od dawna uważa się za wstęp do 
programowania, niezależnie od tego, jaki język się 
studiuje. Uczy najbardziej podstawowych koncepcji 
programowania i wyświetla napis „Hello World” na 
ekranie urządzenia. Choć może się to wydawać proste, nawet niektó-
rzy doświadczeni programiści mogą użyć tego kodu jako testu, próbu-
jąc po raz pierwszy nowego języka lub urządzenia. Kiedy już nauczy-
my się programu „Hello world”, zyskamy pewność, że będziemy mogli 
dalej uczyć się bardziej zaawansowanych rzeczy.

7

GOTOWE!
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Jeśli poprzedni przykład RGB został ukończony przy użyciu programo-
wania blokowego, możesz łatwo przekonwertować kod na programo-
wanie skryptowe w języku Python, aby lepiej zrozumieć różnicę. 
Przełączając się na Pythona, możesz edytować kod i dodać więcej 
funkcjonalności do programu.

Programowanie skryptowe w Pythonie zapewnia większą elastyczność 
i daje kontrolę w  porównaniu do programowania blokowego. Dzięki 
Pythonowi możesz pisać niestandardowy kod i bezpośrednio manipu-
lować zmiennymi, co zapewnia bardziej precyzyjną kontrolę nad pro-
jektem.

W tej sekcji zagłębimy się w funkcje odpowiedzialne za sterowanie 
ruchem zestawu MC4.0, w tym w jaki sposób sterować każdym silni-
kiem, regulować prędkość silnika i  odczytywać wartości enkodera, 
a także pozyskiwać dane ultradźwiękowe, zmieniać kolor oczu urzą-
dzenia MC4.0 i uzyskiwać wartości śledzenia linii.
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Od tego momentu możesz kontynuować naukę i odkrywać bardziej 
zaawansowane koncepcje programowania w języku Python. Dzięki 
prostemu i przyjaznemu interfejsowi naszej platformy, w mgnieniu oka 
staniesz się wykwalifikowanym programistą Pythona.

Po załadowaniu i wybraniu obrazu możesz łatwo przejść do kodu 
Pythona i zobaczyć, jak zainicjować zdjęcie w kontrolerze MC4.0 za 
pomocą Pythona.

Jeśli chcesz wybrać inny obraz spośród już załadowanych, możesz 
skorzystać z  następującej funkcji:

image0: jako obiekt zdefiniowany w poprzedniej linii, funkcja wywo-
łująca obraz: set_img_src - jeden parametr tutaj odnosi się do nazwy 
obrazu

11

Zacznijmy więc od programu „Hello world”.

Kliknij sekcję interfejsu użytkownika w menu bloków, a zauważysz pod-
menu zatytułowane „etykieta”. Wewnątrz etykiety znajdziemy kilka 
różnych bloków, których można użyć do zaprogramowania etykiety 
tekstowej. Na razie wybierzemy pierwszy z  listy. „Label (nazwa_ety-
kiety) show [tekst]. Przeciągnij ten blok do obszaru kodowania i pod-
łącz go do bloku instalacyjnego. Teraz możemy wpisać „hello world” 
w polu tekstowym lub dowolnie inną wiadomość.
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Teraz stworzyłeś swój pierwszy program. To było łatwe, prawda? Aby 
móc działać na urządzeniu MC4.0, musimy się upewnić, że konfigu-
racja sieci Wi-Fi została ukończona lub że kabel USB jest podłączony 
i że wszedłeś w tryb USB zgodnie z instrukcją wyjaśnioną wcześniej.

Dzięki UiFlow dodawanie obrazów do ekranu urządzenia MC4.0 jest 
dziecinnie proste. Po prostu przeciągnij i upuść obiekt „Image” (Obraz) 
z lewego menu w wybrane miejsce na ekranie. Z wyskakującego ko-
munikatu możesz łatwo przesłać swój obraz. Aby zapewnić optymalne 
wyświetlanie, pamiętaj, aby rozmiar obrazu nie przekraczał 50 KB 
i nie był większy niż 320 x 240 pikseli.
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Programowanie skryptowe (Python i C++)

Przygotuj się na przeniesienie swoich umiejętności kodowania 
na wyższy poziom!

Czas przenieść swoje umiejętności programowania na wyższy poziom 
i zanurzyć się w  świecie programowania skryptowego. Dzięki temu 
potężnemu narzędziu możesz tworzyć bardziej złożone programy, do-
dawać więcej funkcjonalności do swojego zestawu i w pełni wykorzy-
stywać możliwości dostępnych czujników i modułów. W tej sekcji 
omówimy podstawy programowania skryptów dla zestawu MC4.0 
i pokażemy, jak napisać pierwsze skrypty, aby sterować zestawem 
w nowy i ekscytujący sposób.

W UiFlow przejście z programowania blokowego na 
programowanie skryptowe w Pythonie jest tak proste, 
jak kliknięcie przycisku. Dzięki temu utworzenie pierw-
szego programu „Hello World” w Pythonie jest dzie-
cinnie proste. Jak wspomnieliśmy wcześniej, program 
„Hello World” to podstawa programowania.

Po utworzeniu programu „Hello World” w programowaniu blokowym 
możesz łatwo przekonwertować go na język Python za pomocą przy-
cisku w UiFlow. Dzięki temu możesz zobaczyć kod Pythona odpowia-
dający użytym blokom.
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Wypróbujmy przykłady tych dwóch czujników!

Ten blok służy do odczytu danych z  czujnika podążania za linią. 
Pierwszy parametr dotyczy konkretnego punktu lub numeru punktu na 
czujniku, z którego chcesz odczytać dane, bo czujnik składa się z 4 
punktów. Drugi parametr dotyczy portu, do którego podłączony jest 
czujnik i można odwoływać się do tej samej numeracji portów, co 
poprzednio. Wreszcie ostatni parametr pozwala wybrać rodzaj wykry-
wania, jaki ma wykonać czujnik, niezależnie od tego, czy jest to wy-
krywanie cyfrowe, analogowe czy kolorowe.

Blok ten może być używany do sterowania oczami RGB. Pierwszy 
parametr określa numer oka, który wynosi 1 dla lewego oka, 2 dla 
prawego oka lub 3 dla obu. Ostatnie trzy parametry określają kolor 
oczu, przy wartościach od 0 do 255 dla koloru czerwonego (R), 
zielonego (G) i niebieskiego (B).
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Po przesłaniu obrazu pamiętaj, aby wybrać go z listy przesłanych 
obrazów w  wyskakującym komunikacie. Wybrany obraz zostanie 
wyświetlony zarówno na ekranie UiFlow, jak i na ekranie urządzenia 
MC4.0.
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Zaczynajmy!

Przygotuj się na dodanie koloru do swojego projektu MC4.0! W na-
stępnym przykładzie przyjrzymy się paskowi RGB znajdującemu się na 
dole MC4.0. Dzięki UiFlow możesz łatwo dostosować wartości RGB 
tak, aby stworzyć własne, niestandardowe kolory i sprawić, że Twój 
projekt będzie się wyróżniał. Zanurzmy się w barwach!

Regulacja długości suwaków powoduje zmianę intensywności każdego 
koloru, co pozwala na stworzenie szerokiej gamy barw. Należy pa-
miętać, że maksymalna wartość dla każdego koloru wynosi 255, więc 
ustawienie suwaków na żądaną długość w tym zakresie da bardzo 
dobre rezultaty.
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Zestaw MC4.0 jest wyposażony w czujnik ultradźwiękowy i czujnik 
podążania za linią, którymi można łatwo sterować za pomocą bloko-
wego języka programowania. Czujnik ultradźwiękowy wyposażony 
jest w oczy RGB, które pozwalają mu wykrywać obiekty i mierzyć 
odległości. Z drugiej strony czujnik podążania za linią przeznaczony 
jest do wykrywania różnych kolorów i jest szczególnie przydatny pod-
czas podążania za liniami lub poruszania się po ścieżkach za pomo-
cą znaczników oznaczonych kolorami.

Za pomocą tego bloku można odczytać wartość ultradźwiękową 
w CM. Liczba w bloku wskazuje port, do którego podłączony jest 
czujnik ultradźwiękowy. Aby określić właściwy port, możesz zapoznać 
się ze specyfikacją portów poniżej.
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Gratulujemy dotarcia do sekcji programowania w MC4.0! Czas na-
pisać swój pierwszy przykład i sprawić, aby samochód poruszał się 
w określonym kierunku za pomocą programowania blokowego 
z UiFlow. To będzie ekscytujący moment, ponieważ zobaczysz, jak 
Twój samochód MC4.0 ożywa, gdy zaprogramujesz go do jazdy.

Ten program umożliwi zestawowi MC4.0 poruszanie się do przodu 
przez 1,5 sekundy, następnie poruszanie się w kierunku prawej strony 
przez 1,5 sekundy, następnie cofanie się przez 1,5 sekundy i na koniec 
poruszanie się w kierunku lewej strony przez taki sam czas.

Przetestujmy inny sposób sterowania zestawem MC4.0!

Ten program sprawi, że 
urządzenie MC4.0 będzie 
poruszać się do przodu 
przez 2 sekundy, a  następ-

nie się zatrzyma. Jeśli jednak chcesz 
mieć większą kontrolę nad ruchem 
silnika, możesz zastosować poje-
dyncze bloki silnika. Bloki te umoż-

liwiają określenie prędkości i kierunku każdego silnika 
z osobna. Aby skorzystać z tych bloków, należy wpro-
wadzić dane do poniższej tabeli, która określa pręd-
kość i  kierunek dla każdego silnika.
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Aby było jeszcze łatwiej, możemy oznaczyć suwaki 
literami R, G i  B odpowiadającymi każdemu kana-
łowi koloru. Dzięki tym etykietom możemy z łatwo-
ścią dodać niezbędne bloki do sterowania diodą 
LED RGB w urządzeniu MC4.0.

Aby rozpocząć programowanie przykładu RGB, mu-
sisz upewnić się, że program działa nieprzerwanie. Dzięki temu, do-
dasz nieskończoną pętlę do swojego kodu. Następnie możesz znaleźć 
konkretny blok paska RGB w zakładce „Hardware” (Sprzęt) w UiFlow. 
Dla każdego koloru możesz użyć odpowiedniego koloru z suwaków.
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Po zakończeniu, możesz kliknąć przycisk „Run” (Uruchom), znajdujący 
się w prawym dolnym rogu ekranu. W tym miejscu, aby wybrać pre-
ferowany kolor, dostosuj suwaki R, G i B.

Zestaw MC4.0 jest wyposażony w koła mecanum, czyli specjalne ko-
ła umożliwiające ruch we wszystkich kierunkach. Koła mecanum posia-
dają unikalną konstrukcję zakrzywionych rolek, które umożliwiają ruch 
koła w dowolnym kierunku, także na boki i  ukośnie. To sprawia, że 
zestaw MC4.0 jest bardzo zwrotny i wszechstronny, ponieważ może 
z łatwością omijać przeszkody i szybko zmieniać kierunki. W następnej 
części przyjrzymy się bliżej możliwościom ruchu kół mecanum i zbada-
my, w jaki sposób pozwalają one MC4.0 poruszać się w dowolnym 
kierunku. Następnie zagłębimy się w  programową stronę rzeczy i zo-
baczymy, jak możemy kontrolować ruch MC4.0 za pomocą UiFlow.
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Teraz, gdy rozumiemy podstawy konstrukcji kół mecanum i sposób ich 
działania, przejdźmy do programowania zestawu MC4.0 do porusza-
nia się przy użyciu programowania blokowego i UiFlow. Tutaj dowiemy 
się, jak używać określonych bloków do sterowania silnikiem, jak ustawić 
prędkość i kierunek silnika oraz jak połączyć te bloki, aby urządzenie 
MC4.0 poruszało się w różnych kierunkach i według różnych wzorów.

Zaczynajmy!


